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Section I: HotDocs Essentials
HotDocs allows you to produce customized documents from HotDocs templates. A HotDocs 
template asks questions and then uses the answers to assemble a document. With HotDocs, you 
can easily edit existing HotDocs templates and create new templates using your Windows word 
processor documents. 

You create a template by inserting HotDocs variables and instructions in place of variable text 
and wherever conditional text occurs in a document. (Variable text is text that changes from one 
use of the document to the next. Conditional text is text that appears in the document only under 
certain conditions.) You can include HotDocs variables that perform computations based on 
other variables.

Documents that can effectively be turned into templates range from simple documents such as 
fax cover sheets, memos, form letters, and invoices,to more complex documents like sales and 
lease agreements, proposals, job bids, and countless legal documents.

HotDocs creates templates right inside your word processor and works with WordPerfect® for 
Windows version 5.2, 6.0a, and 6.1; Microsoft® Word for Windows version 2.0 and 6.0; and 
Lotus® Ami Pro™ for Windows version 3.0 and 3.1.

Note: If you are using WordPerfect 6.0, you must use the WordPerfect 6.0a interim release. HotDocs 
is not compatible with the original WordPerfect 6.0 release.



Chapter 1

Getting Started
This chapter provides instructions for installing and setting up HotDocs and introduces you to 
the HotDocs buttons. If you have been using a previous version of HotDocs, this chapter tells 
you how to convert your earlier templates to HotDocs 3.0 templates. It also explains how to use 
the online Help system and how to reach HotDocs Technical Support.

System Requirements

To run HotDocs you need

• Personal computer with a 386 or higher microprocessor
• VGA or higher resolution color monitor
• Microsoft Windows 3.1 or Windows 95
• Windows word processor (WordPerfect for Windows version 5.2, 6.0a, or 6.1; Microsoft 

Word for Windows version 2.0 or 6.0; or Lotus Ami Pro for Windows version 3.0 or 3.1)
• 2.5 MB hard disk space
• Mouse

Installation Instructions

Note: If you are using WordPerfect 6.1 or 6.0a, you must know the location of the default macro and 
template directories WordPerfect is using before you can install HotDocs. You will be required 
to enter this information during installation. See "Checking WordPerfect Directory Locations," 
below.)

To install HotDocs

1 Close all open Windows word processors. If a previous version of HotDocs is open, hold 
down Alt and press and release Tab until you get to the HotDocs panel. At the HotDocs 
panel, click Exit.

2 If you are installing from floppy disks, insert the HotDocs Disk 1 into drive A or B.

3 At the Windows Program Manager, choose Run from the File menu.
The Run dialog box appears.

4 Type a:install or b:install and click OK.
The installation process begins.

5 Follow the on-screen prompts to complete the installation program.

Note: Word 2.0 users who are upgrading from HotDocs 2.0 to 3.0 must complete the procedure  
for displaying the HotDocs button (even though it still displays) in order to update the 
HotDocs macros. Word 2.0 users also must convert their HotDocs templates from 2.0 to 
3.0. (See "Displaying the HotDocs Button" and "Converting Templates Created with 
Earlier Versions of HotDocs," below.)

Checking WordPerfect Directory Locations



To check the default WordPerfect directory locations

1 From the Edit menu (for 6.1) or the File menu (for 6.0a), choose Preferences.
The Preferences dialog box appears.

2 Double-click the File icon.
The File Preferences dialog box appears.

3 Select Macros.
The dialog box changes to show macro information.

4 If the default macro directory field is empty, enter the WordPerfect Macro directory path. 
Use this path when installing HotDocs.

5 If the default macro directory field contains a directory path, use that path when installing 
HotDocs.

6 Select Templates.
The dialog box changes to show template information.

7 If the default template directory entry is C:\WINDOWS, change the default template 
directory to the WordPerfect template directory. If STANDARD.WPT does not exist in 
the WordPerfect template directory, you will be asked if you want to create it. Click Yes.

Note: If you have made changes to STANDARD.WPT that you want to keep, you will need to 
exit the File Preferences box and use the File Manager to copy STANDARD.WPT  from 
C:\WINDOWS to the WordPerfect template directory.

8 If the default template directory is not C:\WINDOWS, use the displayed directory path 
when installing HotDocs.

Displaying the HotDocs Button

You can use HotDocs 3.0 without displaying the HotDocs button with your word processor's 
default button set. You can open the HotDocs window by double-clicking the HotDocs icon in 
the Program Manager and switch from your word processor to the HotDocs window when 
needed. However, displaying the HotDocs button with your word processor's default button set 
allows you to more quickly access the HotDocs window from within your word processor.

Each word processor requires a different procedure for displaying the HotDocs button. To 
display the HotDocs button, open your word processor and follow the corresponding steps 
below.

WordPerfect 6.1
To display the HotDocs button in WordPerfect 6.1

1 From the Tools menu, choose Macro and then choose Play.
The Play Macro window appears.

2 Type hdcpybar in the Filename box and click Play.
The WordPerfect+HotDocs toolbar is added to the standard template and displayed as the 



current toolbar.

WordPerfect 6.0a
To display the HotDocs button in WordPerfect 6.0a

1 From the Tools menu, choose Macro and then choose Play.
The Play Macro window appears.

2 Type hdcpybar in the Name box and click Play.
The WordPerfect+HotDocs button bar is added to the standard template and displayed as 
the current button bar.

WordPerfect 5.2
To display the HotDocs button in WordPerfect 5.2

1 Right-click the button bar and select hddefaul.wwb from the list of available button bars.
The HotDocs button is displayed with the default button bar.

Microsoft Word 6.0
The HotDocs button is automatically added to the default toolbar during the installation program 
and displayed with the default toolbar when Word 6.0 is opened.

Microsoft Word 2.0
To display the HotDocs button in Microsoft Word 2.0

1 From the File menu, choose Open.
The Open dialog box appears.

2 Select Document Templates (*.dot) as the file type and open the template directory.

3 Select hdsetup.dot in the template directory and click OK.
A message appears confirming HotDocs 3.0 has been successfully set up for use with 
Microsoft Word 2.0.

4 Click OK. From the File menu, choose Exit.
A message appears asking if you want to save the global glossary and command changes.

5 Click Yes.
When you reenter Word, the HotDocs button will be displayed.

Lotus Ami Pro 3.0 and 3.1
To display the HotDocs button in Lotus Ami Pro 3.0 and 3.1

1 From the Tools menu, choose SmartIcons.
The SmartIcons dialog box appears.

2 Select AmiPro+HotDocs from the drop-down list of available SmartIcon sets and click 
OK.
The HotDocs button is displayed with the default SmartIcon set.

Starting and Exiting HotDocs



To start HotDocs 

1 Double-click the HotDocs icon that was added to your Program Manager during 
installation. 
Or
Click the HotDocs button in your word processor's button set.
The HotDocs window appears, where you can create, edit, or use HotDocs templates.

To exit HotDocs

1 Click Exit at the HotDocs window.

The HotDocs Button set

The HotDocs buttons issue the basic HotDocs commands. Whenever a HotDocs template is 
created, the HotDocs button set is automatically displayed. Use this button set to edit a HotDocs 
template. 

The HotDocs button set is the same for each word processor, although button designs vary. The 
order of the buttons illustrated below is, from left to right, HotDocs, Variable, If, Ask, Insert, 
Repeat, Test, Manager, Save, and Close.

You can edit the HotDocs button set to include additional buttons (such as your word processor's 
Open or Search button) that you might use while working in HotDocs.

Note: In WordPerfect 5.2 and in Ami Pro 3.0 and 3.1, the HotDocs button set will remain displayed 
after you close the HotDocs template. To change the button bar in WordPerfect, right-click the 
current button bar and select the button bar you want from the pop-up list (for example, 
hddefault.wwb). To change button sets in Ami Pro, choose SmartIcons from the Tools menu, 
click the drop-down button, and select the button set you want (for example, Ami 
Pro+HotDocs).

Note: In WordPerfect 6.0a and 6.1, the button set that is displayed when you save a template will be 
associated with any documents assembled from that template. Since you will not need the 
HotDocs buttons when you are assembling documents, you should change the button set back to  
the one you prefer when working with documents once you finish working on the template but 
before you save the template for the final time. Save the finished template first using the 
HotDocs Save button (to save all HotDocs components), then change the button set and save the  
template again using WordPerfect's Save command.

Ask Button
The Ask button opens the Dialog Builder. At the Dialog Builder you can create a dialog, reopen 
an existing dialog for editing, or insert an Ask instruction into the template.

Close Button
The Close button closes the template file and corresponding component file you are currently 
using. The template and component files will be saved automatically. If an answer file is open 
and answers have been modified, HotDocs will ask you if you want to save the answers.

You should always use the HotDocs Close button rather than your word processor's Close 



command to close a HotDocs template. Using the HotDocs Close button ensures that the 
template and component files are properly saved and closed.

HotDocs Button
The HotDocs button starts HotDocs if it is not already active and opens the HotDocs window. At 
the HotDocs window, you can create a new template, open an existing template to edit, or use a 
template to assemble documents. You can also edit the library entries and library structure and 
change HotDocs setup options.

If Button
The If button opens the True/False Variable dialog box where you can create a true/false test for 
conditional text. If you need a more complex test than a True/False variable, click Expression at 
the True/False Variable dialog box to open the True/False Expression dialog box. When you 
close the True/False Variable or True/False Expression dialog box, an If instruction using the 
true/false test you created is inserted in the template around the selected text or at the current 
cursor location (if no text has been selected).

Insert Button
The Insert button opens the Insert Template dialog box or the Insert New Template dialog box 
depending on whether text is selected. At the Insert Template dialog box, you can specify an 
existing template you want inserted into your current template. At the Insert New Template 
dialog box, you can convert a selected section of text into a new template and insert the new 
template into your current template.

Manager Button
The Manager button opens the Component Manager. At the Component Manager you can delete 
components (variables, dialogs, formats, and patterns), rename components, and copy 
components from one component file to another.

At the Component Manager, you can also point one component file to another component file, 
and you can change component file preferences.

Repeat Button
The Repeat button opens the Repeat dialog box. At the Repeat dialog box, you can specify a 
dialog to gather the information for a repeat and you can specify a sort order and format for 
merging the information into the document.

Save Button
The Save button saves the template file and corresponding component file you are currently 
using, without closing them. You should always use the HotDocs Save button rather than your 
word processor's Save command to save your HotDocs work. Using the Save button ensures that 
both the template file and the component file are saved.

Test Button
The Test button assembles a document or a selected part of a document. You use Test to test the 
template you are creating or editing. Document assembly will proceed in the same way that it 
will later for the user. When you have answered the questions the template requires, the 
assembled document will appear. You can save or edit the document or print it to see if it is 
assembling the way you want. Close the assembled document or change windows to return to 
the template. If you have selected only part of the template, only that part of the document will 
be assembled.



Variable Button
The Variable button opens the Variable Type dialog box. At the Variable Type dialog box, you 
can select the type of variable you want to create or edit. If your cursor is on a variable reference 
when you click the Variable button, HotDocs will open that variable's dialog box, and you can 
edit the variable.

HotDocs Setup

You can customize the way HotDocs looks and works at the HotDocs Setup dialog box. To open 
the HotDocs Setup dialog box, click Setup at the HotDocs window.

Default Directories
Enter paths in the Answer Files and Component Files boxes to change the default answer file 
and component file directories.

Insert Default Format Examples in New Component Files
Select this option to automatically insert the default format examples in the component file for 
any new template you create. Unselect it to not include the examples automatically. Existing 
component files will not be affected. By default, this option is selected.

Use WordPerfect File Dialogs
If you have HotDocs installed for WordPerfect 6.0a or 6.1, select this option to use 
WordPerfect's file dialogs instead of the common file dialogs. WordPerfect must be running for 
this option to work. Unselect this option to use the common file dialogs even when WordPerfect 
is running. By default, this option is selected.

Sculptured Dialog Boxes
Select this option to have sculptured dialog boxes. By default, this option is selected.

On the Fly Dialog Building
Select this option to have the Dialog Builder button appear on dialogs displayed during test 
assembly. Clicking the button allows you to create or edit a dialog during a test assembly of a 
document. Unselect this option to not have the button appear. By default, this option is 
unselected.

Component File Backup Every ___ Minutes
Enter a number to specify the number of minutes between component file backups. When this 
option is set at 0 (the default), component files are not backed up automatically.

Merge When Unanswered
Select an option to change the format of unanswered variables in an assembled document. When 
Nothing is selected, nothing is merged into the document—not even spaces. When 
***Variable*** is selected, the name of the variable with three asterisks on either side is merged 
into the document. When Underscores is selected, a blank line is merged into the document. 
When Asterisks is selected, three asterisks are merged into the document.

Default Word Processor
If you have HotDocs installed for more than one word processor, select a word processor from 
the drop-down list to be your default word processor. HotDocs uses the default word processor 
when a generic (WordPerfect 5.2) template is selected for assembly at the HotDocs dialog box, 



unless there is a command-line option specifying another word processor. (See Appendix D, 
"Command-Line Options.")

Language
If you are creating templates in multiple languages, select a language from the drop-down list to 
be your current language. (Unless you install one or more optional foreign-language runtime 
DLLs, English will be your only choice.) HotDocs will recognize and return ordinal numbers, 
alpha cardinal numbers and years, month and weekday names, and certain number format 
keywords in the current language. (See Appendix D, "Assembling Non-English Documents.")

Getting Help

You can find answers to your HotDocs questions in the online Help system and by contacting 
HotDocs Technical Support.

Online Help
The HotDocs online Help system includes context-sensitive information for each HotDocs 
dialog box and reference information about all HotDocs features and components. For help at a 
HotDocs dialog box, click Help. For help at other locations, choose HotDocs from your word 
processor's Help menu.

Most Help windows include cross-references to other Help topics. These cross-references are 
displayed in color and underlined. To see a cross-referenced help, click the cross-reference. To 
search for help on a specific topic, click Search at any Help window. To see a list of HotDocs 
Help topics, click Contents.

You can resize or reposition any Help window. You can keep a Help window open while you are 
working on a template by choosing Always on Top from the Help menu in the Help window.

Technical Support
If you are unable to solve a problem using the manual and the online Help system, call HotDocs 
Technical Support at (801) 763-3960 between 8:00 a.m. and 5:00 p.m. MT or send a message to 
help@capsoft.com.

You can also get help for your HotDocs projects and the latest information from Capsoft by 
dialing the Capsoft Bulletin Board or accessing the Capsoft home page on the World-Wide Web.

Capsoft Bulletin Board
At the Bulletin Board you can

• Read and download files from libraries that include information about document 
assembly, technical information, sample templates, and foreign-language runtime DLLs

• Download the latest version of the online Help system
• Get the latest information about Capsoft products and events like the annual Capsoft 

Users Conference
• Share information and talk with other users

To call the Bulletin Board

1 Set your modem to 8N1 and ANSI mode.
2 Dial (801) 763-9814.
3 Enter the requested information and assign your own user ID and password.



4 Follow the on-screen instructions.

Capsoft Home Page
You can access the Capsoft home page at http://www.capsoft.com/÷capsoft.



Chapter 2

HotDocs in Brief
This chapter is for those who want to begin using HotDocs with a minimum of instruction. 
For a tutorial on the basics of assembling documents and creating templates, see "HotDocs 
Basics" in Learning HotDocs. For complete instructions, see the other sections of this manual.

Assembling a Document

To assemble a document

1 Double-click the HotDocs icon at the Program Manager, or click HotDocs at your word 
processor.
The HotDocs window appears.

2 Select the template you want to use and click Assemble.
The Assembly Options dialog box appears.

3 Select Document and one of the Ask options.

4 Select an answer file.
• If you want to use an existing answer file to provide answers for the document, click 

Open and select an answer file at the Open Answer File dialog box.
• If you want to create a new answer file to save your answers in, click Save As and 

specify an answer file at the Save Answer File As dialog box.
• If you do not want to save your answers, leave Untitled in the Current Answer File 

box.

5 Click OK at the Assembly Options dialog box.
The first dialog appears.

6 Answer each question and click OK to advance.
When you are finished answering questions, HotDocs displays the assembled document. 
You can save or print the document using your word processor's commands.

Creating a Template

There are four basic steps to creating a template:
• Creating a template file
• Creating variables
• Creating tests for conditional text
• Creating dialogs

Creating a Template File
When you create a new template file at the HotDocs window, the template is automatically 
added to the library that is currently open. The template will be included in the folder you have 
selected.

To create a template file



1 Double-click the HotDocs icon at the Program Manager, or click the HotDocs button at 
your word processor.
The HotDocs window appears.

2 Select the folder you want to place the new template in.

3 Click Create.
The Create Template dialog box appears.

4 Enter a title, filename, and brief description (optional) for the template.

5 Under New Template Contents, select Other File and enter the path and filename of the 
document you want to convert to a template.

6 Click OK.
The template is created containing your document text and is opened, ready for you to 
automate.

Creating Variables
When you create a HotDocs template, you must replace variable text with variables. Variable 
text is text that changes from one use of a template to the next—such as names, dates, and 
numbers.

To insert a variable

1 Select the text you want to replace and click the HotDocs Variable button.
The Variable Type dialog box appears.

2 Select the type of variable you want to replace the selected text and click OK.
The variable dialog box for the type of variable you selected is displayed.

3 Enter a name for the variable in the Variable Name field and define any additional 
attributes you want the variable to have.

4 When you are finished at the variable dialog box, click OK.
The Replace dialog box appears.

5 Select an option to indicate how you want HotDocs to proceed with inserting the variable 
throughout the template.

Creating Tests for Conditional Text
Conditional text is text that may or may not be included in a document. Often, you may want to 
include conditional text based on the answer to a simple yes/no question. At other times, you 
may want to include conditional text based on a more complex condition.
You can make text conditional using a True/False variable or a True/False expression.

True/False Variable
A True/False variable allows you to include conditional text based on a yes/no question.

To make text conditional using a True/False variable



1 Select the text you want to make conditional and click the HotDocs If button.
The True/False Variable dialog box appears.

2 Type a name for the variable and click If.
HotDocs surrounds the selected text in the template with the If instruction.

When the template is used to assemble the document, a yes/no question is asked.
If the user chooses yes, the conditional text will be inserted into the template.

True/False Expression
A True/False expression allows you to include conditional text based on complex conditions. 
For example, in a will, a paragraph naming a legal guardian would be necessary if the maker has 
children and at least one of the children is a minor.

To insert conditional text using a True/False expression

1 Select the text you want to make conditional and click the HotDocs If button.
The True/False Variable dialog box appears.

2 Click Expression.
The True/False Expression dialog box appears.

3 Write a True/False expression by dragging and dropping variables, operators, models, and 
instruction keywords into the Expression box.

4 Click If.
HotDocs surrounds the selected text in the template with the If instruction.

Creating Dialogs
Once you have inserted variables and identified conditional text in a template, HotDocs will 
automatically generate a question for each variable. If this method of gathering data is adequate, 
you do not need to build custom dialogs.

However, custom dialogs afford you a number of options not otherwise available. For example, 
in a custom dialog, you can group related questions together. You can also provide additional 
information about questions that will help clarify the questions for the person assembling the 
document.

To build a custom dialog

1 Click the HotDocs Ask button.
The Dialog Builder appears.

2 Type a name for the dialog in the Dialog Name box.

3 Drag and drop variables from the Variables list into the Dialog Contents box in the order 
you want them to appear in the dialog.

4 When you are finished creating the first dialog, you can type a name for another dialog in 
the Dialog Name box to clear the Dialog Contents box.



5 When you are finished building dialogs, click Done.



Section II: Basic Tutorial
This section walks you through the process of using a HotDocs template to assemble a 
document. It then shows you step-by-step how to create and automate the template you just 
used. You can complete the lessons in this section one at a time or all at once, but you should 
complete them in order.



Lesson 1

Assembling a Document
Each time you use a template to assemble a document, HotDocs displays a series of dialogs that 
prompt you to provide variable information (information that is different for each document), 
such as names, dates, and instructions for conditional paragraphs. Once you have entered the 
information the template requires, HotDocs merges your answers and carries out your 
instructions to produce a finished document. The document can then be printed, saved, or edited.

To see how a completed HotDocs template produces a customized document, follow the steps 
below. You will assemble an employment agreement using a previously created template. (You 
will learn how to create this template in the next six lessons.)

Note: The employment agreement document was drafted to suit the purposes of the tutorial. The 
document is not provided as a valid legal document.

To assemble the employment agreement document

1 At the Program Manager, double-click the HotDocs icon.
The HotDocs window appears.

Note: If the Learning HotDocs folder does not appear, click Library, choose Open, select the 
3.0 library for your word processor (for example, msw60_30.hdl for Word 6.0), and click  
OK.

2 Select Demo Employment Agreement from the Learning HotDocs folder and click 
Assemble.
The Assembly Options dialog box appears.

The Assembly Options dialog box shows the current answer file. Leave the answer file 
untitled for now. You can also select what to assemble and the template questions that 
will be asked.

3 Select Document and All and click OK.
The dialog Information about Employee appears.

4 Enter any name (first name first) in the Employee Name field, select a gender, and click 
OK to advance.
The dialog Information about Agreement appears.

5 Continue answering questions as dialogs appear.
After you have advanced past the final dialog, HotDocs displays a dialog box allowing 
you to save the information you entered.

6 Choose Don't Save at the dialog box. For now, you do not need to save your answers.
The assembled employment agreement document appears. The information you entered 
in the dialogs has been used to assemble the document. You can print, save, or edit the 
document.

7 From the File menu, choose Close to close the document.



You do not need to save the document.

The following lessons will guide you in preparing an employment agreement template from an 
ordinary word processor document.



Lesson 2

Creating a Template File
The first step in creating the template is to create a HotDocs template file and insert the word 
processor employment agreement document into the file. Putting your document into a template 
file lets you use HotDocs template-building features.

1 At your word processor, click the HotDocs button located in your word processor's 
default button set. (If the HotDocs button is not displayed, see "Displaying the HotDocs 
Button" in Chapter 1, "Getting Started," in the HotDocs User's Guide.)
The HotDocs window appears.

2 Select the Learning HotDocs folder.

3 Click Create.
The Create Template dialog box appears.

4 Type Employment Agreement in the Title box and learn30 in the Filename box.

5 Select Other File and click the Browse button to the right of the Other File box.
The Filename dialog box appears.

6 Select the employment agreement, employ, located in the default document directory 
specified during installation. (The document will have a two- or three-letter extension 
depending on your word processor.) Click OK to return to the Create Template dialog 
box.
The path and filename of the employment agreement are inserted into the Other File box.

7 Click OK.
The new template file is created, and the employment agreement document is inserted 
into it.
The template is ready for you to automate.

Whenever a HotDocs template is created, the HotDocs button set is automatically displayed. 
Use this button set to edit the HotDocs template. The button designs vary depending on the 
word processor you are using.

The order of the buttons is the same for all word processors.  The buttons are, from left to right, 
HotDocs, Variable, If, Ask, Insert, Repeat, Test, Manager, Save, and Close. (In some word 
processors, the HotDocs button will be separated from the editing buttons.)

If you do not want to go on to Lesson 3 at this time, click the HotDocs Close button to save and 
close the template. (You should always use the HotDocs Save button to save your work, or the 
HotDocs Close button to save and then close a template, rather than your word processor's Save 
and Close commands. Using the HotDocs buttons ensures the template is properly saved and 
closed.)



Lesson 3

Replacing Text and Dates
After you have created a template file, the next step is replacing variable information 
(information that is different for each document) with HotDocs variables. This lesson will teach 
you how to replace text and dates and how to create prompts for variables. 

If you are continuing immediately from Lesson 2, skip the instructions for opening the template 
and proceed to "Replacing Text."

If you closed the template at the end of Lesson 2, follow the instructions below.

To open the Employment Agreement template you created in Lesson 2

1 Open your word processor and click the HotDocs button.
The HotDocs window appears.

2 Select Employment Agreement and click Edit.
The template appears, ready for you to edit.

Replacing Text

The first instance of text that needs to be replaced in the template is the name of the employee, 
Aaron Jameson, in the first paragraph.

To replace the name of the employee with a HotDocs variable

1 Select (highlight) Aaron Jameson.

2 Click the HotDocs Variable button.
The Variable Type dialog box appears.

The dialog box lists several types of variables. The text you selected, Aaron Jameson, 
should be replaced with a Text variable.

3 Click OK to accept the default setting, Text.
The Text Variable dialog box appears.

4 Type Employee Name in the Variable Name box.

5 Click OK.
The Replace dialog box appears.

6 Click All.
Clicking All causes HotDocs to replace every instance of the text Aaron Jameson in the 
document with the variable Employee Name. Later, when you assemble a document, 
HotDocs will ask you for the employee name and then merge that name into the 
document everywhere the variable Employee Name has been inserted.

Replacing Dates



The first variable date in the template is the date of the agreement, 12th day of October, 1995.

To replace the date with a HotDocs variable

1 Select 12th day of October, 1995 and click the HotDocs Variable button.
The Variable Type dialog box appears.

2 Select Date and click OK.
The Date Variable dialog box appears.

Notice that the Format Example box contains a format example. A format example 
controls the format of an answer when it is merged into a document. HotDocs 
automatically provides a format example for date and numeric answers that corresponds 
with the format of the selected text. To change the format, you can select a new example 
from the Format Example drop-down list.

3 Type Date of Agreement in the Variable Name box and click OK.
The Replace dialog box appears.

4 Click All.

In addition to the variable name, Date of Agreement, the special format for the Date 
variable, 3rd day of June, 1990, is displayed at the merge field. (The date June 3, 1990, is 
used for all date format examples.)

On Your Own

The second variable date is the hire date, November 1, 1995. Replace November 1, 1995 with a 
Date variable named Hire Date. (Follow the instructions for creating the variable Date of 
Agreement, above.)

The second item of text that needs to be replaced is the job title, Editorial Assistant. Replace 
Editorial Assistant with a Text variable named Job Title. (Follow the instructions for creating the 
variable Employee Name, above.)

Creating Prompts and Changing Answer Field Size

The third item of text that needs to be replaced is the list of job duties in the second paragraph.

To replace the list of job duties with a HotDocs variable

1 Select evaluating manuscripts, copy editing, and proofreading and click the 
HotDocs Variable button.

2 Click OK.
The Text Variable dialog box appears.

3 Type Job Duties in the Variable Name box.

4 Click Test to see how the variable question will appear to the user.



The test dialog box appears.

HotDocs automatically uses the variable name as the prompt. In this case, the name does 
not make a good prompt because it doesn't help the user's answer fit into the rest of the 
sentence. Also, the answer field is small considering this answer could be quite long.

5 Click Cancel to return to the Text Variable dialog box.

6 In the Prompt box, type Complete the following sentence: Job duties shall include

7 At the No. of Lines box, click the up arrow until the number 4 appears.

8 Click Test again.
The new prompt appears and the answer field is four lines high.

9 Click Cancel at the test dialog, click OK at the variable dialog box, and click All at the 
Replace dialog box.

If you do not want to go on to Lesson 4 at this time, click the HotDocs Close button to save and 
close the template.



Lesson 4

Replacing Numbers
This lesson will teach you how to replace variable numbers, both simple and computed, and 
how to insert an existing variable with a different format.

If you are continuing immediately from Lesson 3, skip the instructions for opening the template 
and proceed to "Replacing Simple Numbers."

If you closed the template at the end of Lesson 3, follow the instructions below.

To open the Employment Agreement template you used in Lesson 3

1 Open your word processor and click the HotDocs button.
The HotDocs window appears.

2 Select Employment Agreement and click Edit.
The template appears, ready for you to edit.

Replacing Simple Numbers

The first variable number in the template is the monthly salary, 2,000. 

To replace the monthly salary with a HotDocs variable

1 Select 2,000 (do not select the $ character) and click the HotDocs Variable button.
The Variable Type dialog box appears.

2 Select Number and click OK.
The Number Variable dialog box appears.

3 Type Monthly Salary in the Variable Name box and click OK.
The Replace dialog box appears.

Note: Clicking All would replace all instances of 2,000—even those that are part of other 
numbers, such as 12,000. If there is more than one instance of 2,000, click Confirm. If 
there is only one, click Once.

4 Click Once.

Replacing Computed Numbers

The second variable number is the yearly salary. You could replace the yearly salary with a 
Number variable. This would require the user to multiply the monthly salary by twelve. Or, to 
save the user time and reduce the chance of a mistake, you could replace the yearly salary with a 
Computation variable, which would do the multiplication for the user.

To replace the yearly salary with a Computation variable

1 Select 24,000 (do not select the $ character) and click the HotDocs Variable button.



2 Select Computation and click OK.
The Computation dialog box appears.

3 Type Yearly Salary in the Variable Name box.
You need to multiply the monthly salary by 12.

4 Drag Monthly Salary from the Variables list into the Computation box.

5 Drag the multiplication sign (*) from the Operators list into the Computation box 
following Monthly Salary.

6 Type 12 in the Computation box following the multiplication sign. Make sure there is a 
space on either side of the multiplication sign.

7 Click Test to test the computation.
HotDocs prompts you to enter the amount of the monthly salary.

8 Type 1500 for the monthly salary and click OK.
The computation result, 18,000, is displayed.

9 Click OK at the Result dialog box, then click OK at the Computation Variable dialog box 
and click Once at the Replace dialog box.
The Computation variable is inserted into the template.

Setting Minimum and Maximun Limits

The third variable number, TEN, is in the third paragraph. All Hobble Creek Publishing 
employees receive at least eight paid vacation days, but they can have no more than fifteen. You 
can use the Minimum and Maximum boxes to prevent users from entering a number smaller 
than eight or larger than fifteen.

To replace the number with a Number variable

1 Select TEN and open the Number Variable dialog box (by clicking the HotDocs Variable 
button and selecting Number).

2 Type Number of Vacation Days in the Variable Name box.

3 Type 8 in the Minimum box and 15 in the Maximum box.

4 Click Test.
The test dialog box appears.

5 Type 7 and click Result.
The warning "Number of Vacation Days must be greater than or equal to 8" appears.

6 Click OK to return to the test dialog box.

7 Click Cancel to close the test dialog box and then click OK at the Number Variable 
dialog box.



The Replace dialog box appears.

Note: Clicking All would replace all instances of TEN (or Ten or ten)—even those that are 
part of other words, such as written. If there is more than one instance of TEN you want 
replaced, click Confirm. If there is only one, click Once.

8 Click Once.
The variable is inserted into the template.

Inserting Existing Variables

The next variable number, 10, has the same value as the previous number, but it is formatted 
differently. Instead of creating a new variable, you can use the variable you just created. 
Remember, the same variable can be referenced several places in a document. The variable's 
format can be different at different locations.

To replace the number with the variable you just created

1 Select 10 and open the Number Variable dialog box.

2 Click the Variable Name drop-down button to see the drop-down list of variables.

3 Select Number of Vacation Days from the list.
The variable Number of Vacation Days appears in the dialog box. (Since 10 is in the 
default format, nothing appears in the Format Example box.)

4 Click OK and then click Once at the Replace dialog box.

On Your Own

The fourth paragraph also contains a variable number, three. Replace three with a Number 
variable named Number of Seminar Days.

If you do not want to go on to Lesson 5 at this time, click the HotDocs Close button to save and 
close the template.



Lesson 5

Creating Conditional Text and
Replacing Multiple-Choice Text

This lesson teaches you how to make sections of text conditional, how to replace multiple-
choice text, and how to add help text to variables. Conditional text is text that appears in a 
document only under certain conditions. Multiple-choice text is text the user selects from several 
options.

If you are continuing immediately from Lesson 4, skip the instructions for opening the template 
and proceed to "Creating Conditional Text."

If you closed the template at the end of Lesson 4, follow the instructions below.

To open the Employment Agreement template you used in Lesson 4

1 Open your word processor and click the HotDocs button.
The HotDocs window appears.

2 Select Employment Agreement and click Edit.
The template appears, ready for you to edit.

Creating Conditional Text

Not all Hobble Creek Publishing employees have paid seminar days or trial periods, so the 
fourth and fifth paragraphs need to be designated as conditional. Conditional paragraphs are 
included in a document only if certain conditions are true. In this case, we want these paragraphs 
included if the person assembling the document selects them.

To make text conditional, you use an If instruction.

An If instruction works by testing to see if one or more conditions exist. If the conditions do 
exist, the If instruction merges the conditional text into the document. The simplest way to 
create a condition is with a True/False variable, which asks a yes/no question. If the answer to 
the question is "yes," the text is merged into the document.

1 Select the fourth paragraph.
When your paragraphs are separated by one or more blank lines (as they are in this 
template), you need to select the blank lines each time you select a paragraph to make it 
conditional. You also need to be consistent in the way you select the lines. For example, 
if you select the blank lines following one paragraph you want to make conditional, 
always select the blank lines following the paragraphs. This will make the spacing in 
your documents consistent.

2 Click the HotDocs If button.
The True/False Variable dialog box appears.

3 Type Paid Seminar Days in the Variable Name box and click If.
The paragraph is now surrounded by an If instruction.



On Your Own

Make the fifth paragraph conditional following the instructions above. Name the True/False 
variable Trial Period.

Replacing Multiple-Choice Text

The fourth paragraph contains a pronoun ("provided that he plans attendance"). Pronouns are 
usually replaced by Multiple Choice variables. A Multiple Choice variable lets the user choose 
an answer from a list of options.

To create a Multiple Choice variable that provides a pronoun for the employee

1 Select he and click the HotDocs Variable button. Select Multiple Choice and click OK.
The Multiple Choice Variable dialog box appears.

2 Type Gender of Employee in the Variable Name box.

3 Type Male in the first row of the Options column and Female in the second row. 
These are the options the user will choose from, but we want pronouns merged in. A list 
of common pronoun sets is available.

4 Click the Merge Text title button.
A list of common pronoun sets appears.

5 Select he/she.
The pronoun he appears in the first row of the Merge Text column and she appears in the 
second row.

6 Click OK at the Multiple Choice Variable dialog box.
The Replace dialog box appears.

Note: Clicking All would replace all instances of he—even those that are part of other words, 
such as the. If there is more than one instance of he you want replaced, click Confirm. If 
there is only one, click Once.

7 Click Once.
The pronoun is replaced with the variable.

Changing Multiple-Choice Merge Text

The fifth paragraph contains a different pronoun ("and upon his performance")  for the same 
person (the employee). Instead of creating a new variable to replace this pronoun, you can use 
the Multiple Choice variable you just created if you change the merge text.

To replace the pronoun and change the merge text

1 Select his and open the Multiple Choice Variable dialog box.

2 Click the Variable Name drop-down button to see the drop-down list of variables.



3 Select Gender of Employee from the list.
The Gender of Employee variable appears.

4 Click the Merge Text title button.
A list of common pronoun sets appears.

5 Select his/her and click OK at the variable dialog box.
The Replace dialog box appears.

6 Click Once.

Adding Help Text

The final item of text that needs to be replaced is the name of the company representative who 
signs the agreement. There are only three Hobble Creek Publishing employees who sign 
employment agreements: Stephanie Walker, Ed Hall, and Kathryn Lee.

To replace Stephanie Walker with a Multiple Choice variable

1 Select Stephanie Walker and open the Multiple Choice Variable dialog box.

2 Type Company Representative in the Variable Name box.

3 On separate rows in the Options column, type Stephanie Walker, Ed Hall, and Kathryn 
Lee.

Since you want the name you select to be merged into the document, do not enter Merge 
Text for the options. If the Merge Text box is empty, the text in the Options box will be 
merged.

Users might not know which name to select for each agreement. You can add text to help 
them select the correct name.

4 Click Add Help.
The Enter Help dialog box appears.

5 Type Stephanie Walker signs for editorial employees, Ed Hall for marketing, and 
Kathryn Lee for production. Click OK.
The Multiple Choice Variable dialog box appears again.

6 Click Test.
The test dialog box appears.

7 Click Help.
The Help box appears containing the variable name and your help text.

8 Click Exit at the Help dialog box, click OK at the test dialog box and the variable dialog 
box, and then click All at the Replace dialog box.

If you do not want to go on to Lesson 6 at this time, click the HotDocs Close button to save and 



close the template.



Lesson 6

Testing a Template
This lesson teaches you how to assemble a document while you are creating or editing a 
template to test if the template is working the way you want.

If you are continuing immediately from Lesson 5, skip the instructions for opening the template 
and proceed to "Assembling the Document."

If you closed the template at the end of Lesson 5, follow the instructions below.

To open the Employment Agreement template you used in Lesson 5

1 Open your word processor and click the HotDocs button.
The HotDocs window appears.

2 Select Employment Agreement and click Edit.
The template appears, ready for you to edit.

Assembling the Document

To test the employment agreement template

1 Click the Test button in the HotDocs button set.
The Assembly Options dialog box appears.

2 Click OK at the Assembly Options dialog box and answer the questions for the variables 
and the If instructions you created. (At each dialog, enter an answer and click OK to go to 
the next dialog.)
The assembled document appears after the final dialog.

Note: In WordPerfect and Ami Pro, the HotDocs button set will still be displayed.  (The buttons will 
not work because the document is not a HotDocs template.) For information on changing the 
button set when you are through editing a template, see "The HotDocs Button Set" in Chapter 1,  
"Getting Started," in the HotDocs User's Guide.

3 From the word processor File menu, choose Close. (Do not save the assembled 
document.) You are returned to the template.

If you do not want to go on to Lesson 7 at this time, click the HotDocs Close button to save and 
close the template. You do not need to save your answers.



Lesson 7

Creating Dialogs
This lesson teaches you how to build custom dialogs for a template.

Once you have automated a template, HotDocs will automatically ask all the required questions
—with each question in its own dialog—when you assemble a document. If this method of 
information gathering seems adequate, you do not need to build custom dialogs for the template.

However, custom dialogs allow you to group related questions together and control the order of 
questions.

If you are continuing immediately from Lesson 6, skip the instructions for opening the template 
and proceed to "Building a Custom Dialog."

If you closed the template at the end of Lesson 6, follow the instructions below.

To open the Employment Agreement template you used in Lesson 6

1 Open your word processor and click the HotDocs button.
The HotDocs window appears.

2 Select Employment Agreement and click Edit.
The template appears, ready for you to edit.

Building a Custom Dialog

How you divide variables (questions) into dialogs depends on the template and your own 
preferences. Generally, you begin with the most basic information. In the employment 
agreement, the most basic information pertains to the employee.

To build a custom dialog containing employee information

1 Click the HotDocs Ask button.
The Dialog Builder appears.

2 Type Information about Employee in the Dialog Name box.

3 Drag Employee Name from the list of variables into the Dialog Contents box.

4 Drag Gender of Employee into the Dialog Contents box.

5 Click Test.
The test dialog appears.
The dialog looks exactly the way it will when it is displayed during the assembly process.

6 Click Cancel to return to the Dialog Builder. (Do not close the Dialog Builder.)
The dialog Information about Employee is now complete.

Building the Second Dialog



You can create additional dialogs without closing and reopening the Dialog Builder. To clear the 
Dialog Contents box so you can create a new dialog, type a new name in the Dialog Name box.
Another group of variables pertains to information about the agreement.

To create a dialog containing agreement information

1 Type Information about Agreement in the Dialog Name box.
The Dialog Contents box is once again empty, allowing you to choose variables for the 
new dialog.

2 Drag Date of Agreement and Company Representative into the Dialog Contents box.

On Your Own

Create a dialog named Information about Job that contains the variables Hire Date, Job Title, 
and Job Duties.

Grouping True/False Variables in a Dialog

Two of the remaining variables are True/False variables (Paid Seminar Days and Trial Period). 
By default, True/False variables display as yes/no questions. However, you can group True/False 
variables into single-selection or multiple-selection lists.

To create a dialog and group its True/False variables

1 Type Salary and Benefits in the Dialog Name box.

2 Drag Monthly Salary, Number of Vacation Days, Paid Seminar Days, and Trial 
Period into the Dialog Contents box.

3 Click Test.
The dialog appears.
The two True/False variables have created two yes/no questions (true/false questions). If 
you select Yes for one of these questions, a conditional paragraph will be included in the 
assembled document. This dialog will work as it is; however, you can make it more 
efficient by grouping the two variables into one multiple-selection list.

4 Click Cancel to return to the Dialog Builder.

5 Click Style.
The Dialog Style dialog box appears.

6 Under True/False Grouping, select Select All that Apply and then click OK.

7 Click Test.
The layout of the dialog has changed.
To include a particular paragraph in the document, the user clicks the box to the left of 
the option. To exclude a paragraph from the document, leave the option box unchecked or 
click it a second time.



8 Click Cancel at the dialog to return to the Dialog Builder.
The remaining variable, Number of Seminar Days, needs to be in a separate dialog since 
it only appears when Paid Seminar Days is true. HotDocs will automatically ask it in its 
own dialog, so there is no need to create a custom dialog for this variable.

9 Click Done to close the Dialog Builder.
The Employment Agreement template is complete.

10 Click the HotDocs Save button to save the template.

Testing the Finished Template

To test the finished template and see the dialogs you created

1 Click the Test button in the HotDocs button set.
The Assembly Options dialog box appears.

2 Click OK at the Assembly Options dialog box.
The dialog Information about Employee appears.

3 Answer the questions and click OK.
The dialog Information about Agreement appears.

4 Continue answering questions as dialogs appear.
After you have advanced past the final dialog, HotDocs displays the assembled 
document.

5 From the word processor File menu, choose Close to close the document.
You do not need to save the document.
You are returned to the HotDocs template.

6 Click the HotDocs Close button.
HotDocs displays a dialog box allowing you to save the answers you entered.

7 Click Don't Save.
The answers are not saved, and the template is saved and closed.



Section III: Advanced Tutorial
This section shows you how to perform a variety of advanced HotDocs tasks:

· Using models
· Using Repeat instructions
· Creating tables
· Using If instructions
· Inserting one template into another

You can complete these lessons in any order you choose.



Lesson 8

Using Models
You can use models when writing computations and True/False expressions to help you with the 
correct syntax and to produce values that would be difficult or impossible to produce in 
HotDocs otherwise.

In this lesson, you will create a complex computation using several models. The computation 
merges the date that insurance coverage begins into a letter explaining insurance benefits to a 
new Hobble Creek Publishing employee.

For a description and example of each model, see Appendix A, "Models," in the HotDocs User's  
Guide. For additional information about using models in Computation variables and True/False 
expressions, see Chapter 14, "Computation Variables," and Chapter 17, "If Instructions," in the 
HotDocs User's Guide.

Opening the Insurance Letter Template

To open the Insurance Letter template for editing

1 At your word processor, click the HotDocs button.
Or
At the Program Manager, double-click the HotDocs icon.
The HotDocs window appears.

2 From the Learning HotDocs folder, select Insurance Letter.

Note: If the Learning HotDocs folder does not appears, click Library, choose Open, select the 
3.0 library for your word processor (for example, msw60_30.hdl for Word 6.0), and click  
OK. Then complete step 2.

3 Click Edit.
The template is opened for you to edit. The automation is mostly complete, but the 
insurance effective date needs to be computed.

Inserting a Model in a Computation Variable Dialog Box

At the end of the first paragraph, an If instruction is used to return the date an employee's 
insurance coverage becomes effective. If the employee was hired on the first day of the month, 
the coverage begins on the hire date. Otherwise, the coverage begins on the first day of the 
month following the hire date. 

This second date is currently represented by a blank line. You need to create a Computation 
variable that returns this date and insert the variable into the template in place of the line. You 
will use several models to create the variable. 

1 Select the blank line between ELSE and END IF.

2 Click the HotDocs Variable button.
The Variable Type dialog box appears.



3 Select Computation and click OK.
The Computation Variable dialog box appears.

4 Type Insurance Effective Date in the Variable Name box.

5 Drag DATE OF(NUM, NUM, NUM) from the list of models to the Computation box.

Replacing a Placeholder With a Value

The DATE OF model has three placeholders for required number values. The number values 
represent a day, month, and year, respectively. You know the insurance needs to start on the first 
day of the month, so you want the first NUM placeholder to be replaced by 1.

1 From the list of models, drag Enter a Number onto the first NUM placeholder.
The Enter a Number dialog box appears.

2 Type 1 and click OK.
The number 1 replaces the first NUM placeholder.

Replacing Placeholders with Other Models

You can also replace placeholders with other models.

The second NUM placeholder represents the numeric equivalent of a month. You cannot simply 
enter a number like you did for the day, because the month you want depends on the hire date. 
Instead, you should use the MONTH OF(DATE) model, which returns the numeric equivalent 
of a month.

1 Drag MONTH OF(DATE) onto the second NUM placeholder.
You want the MONTH OF model to return the number for the month following the 
month of hire. In other words, you want to add a month to the month of hire. The DATE 
+ NUM MONTHS model helps you do this.

2 Drag DATE + NUM MONTHS onto the DATE placeholder.

Replacing a Placeholder with a Variable

Placeholders are often replaced with HotDocs variables. The DATE + NUM MONTHS model 
has two placeholders—DATE and NUM. (MONTHS is a keyword that remains in the finished 
computation.) The DATE placeholder needs to be replaced with the date the employee was 
hired.

1 Drag Hire Date from the Variables list onto the DATE placeholder.
Or
Select the DATE placeholder, select Hire Date from the Variables list, and press the 
Insert key. (You can always use the Insert key to insert a selected variable, model, 
operator, or instruction keywords into the Computation box at the current cursor 
location.)

On Your Own



Replace the NUM placeholder in the DATE + NUM MONTHS model with the number 1. 
Replace the remaining NUM placeholder in the DATE OF (NUM, NUM, NUM) model with 
YEAR OF(Hire Date).

When you are finished, the Computation variable should look like the example below.

When you have finished the computation, click OK at the Computation Variable dialog box and 
Once at the Replace dialog box to insert the variable in the template. Then click the HotDocs 
Close button to save and close the template.



Lesson 9

Using Repeats
Sometimes you need to repeat a section of your document that contains HotDocs variables. The 
section needs to be repeated a different number of times each time you use the document, and 
the HotDocs variables need to contain different values in each repetition. HotDocs Repeat 
instructions allow you to handle situations like this.

In this lesson you will work with a template that reports the book contracts Hobble Creek 
Publishing has entered into in the last quarter. The template contains a list of authors and 
tentative titles merged into a sentence. A paragraph describing each book follows the list. A 
second list merges the authors and titles for mystery novels only. You can create both the 
sentence list and the repeating paragraphs using Repeat instructions.

For additional information on Repeat instructions, see Chapter 19, "Repeat Instructions," in the 
HotDocs User's Guide. For information on using Repeat instructions in tables, see Lesson 10, 
"Creating Variable-Length Tables."

Opening the Contract Report

To open the Contract Report template for editing

1 In your word processor, click the HotDocs button.
Or
At the Program Manager, double-click the HotDocs icon.
The HotDocs window appears.

2 From the Learning HotDocs folder, select Contract Report.

Note: If the Learning HotDocs folder does not appears, click Library, choose Open, select the 
3.0 library for your word processor (for example, msw60_30.hdl for Word 6.0), and click  
OK. Then complete step 2.

3 Click Edit.
The template opens for editing. Most of the automation is complete, but the lists need to 
be created and the paragraphs repeated.

Creating a Variable-Length List with Sentence Format

In the first paragraph, you want to merge in the author's name and the book's tentative 
title for each contract that was signed.

To create the list of authors and titles

1 Select «Author» («Tentative Title») in the first section. Do not select the period.

2 Click the HotDocs Repeat button.
The Repeat dialog box appears.

3 Click New/Edit to create a new dialog.



The Dialog Builder appears.

4 Type Novel Information in the Dialog Name box.
Author is a Computation variable that combines three Text variables: First Name, Middle 
Name, and Last Name.

5 Drag First Name, Middle Name, Last Name, and Tentative Title from the Variables 
list to the Dialog Contents box and click Done.
You are returned to the Repeat dialog box. Novel Information appears in the Repeated 
Dialog box.

You want the list to be merged into the sentence, with a comma after each entry except 
the last and the word and before the last entry. You can specify this format by selecting 
the corresponding format example.

6 Click the Format Example drop-down button and select a, b, and c from the list.

7 Click OK.
The Repeat instruction is inserted into the template around «Author» («Tentative Title»).

Entering List Information

Test the list to practice entering list information.

1 Select the first paragraph. Be sure to include the final period.

2 Click the HotDocs Test button.
The Assembly Options dialog box appears.

Note: Ami Pro users may see a message warning that There is a field in the selection to be 
deleted. Would you like to continue? Click Yes to continue.

3 Select Document and All and click OK.
The dialog Novel Information appears.

4 Enter answers for the first novel and click OK.
The empty Novel Information dialog appears again. The number in the dialog title has 
increased.

5 Enter answers for the second novel and click OK.

6 Enter answers for as many novels as you want. When you are through, click OK at an 
empty Novel Information dialog.
The assembled list appears. The information is listed in the order you entered it.

7 Close the test document to return to the template.

Sorting a List

If you want the list information to appear in a specific order, you can sort the list. You can sort a 
list in either ascending or descending order according to any variable in the repeated dialog. In 



this case, sort the list alphabetically by the author's last name.

To sort the list alphabetically by the author's last name

1 Position the cursor on REPEAT.

2 Click the HotDocs Repeat button.
The Repeat dialog box for the Repeat instruction appears.

3 Click Sort.
The Sort dialog box appears.

4 Click the Sort By drop-down button to display the list of variables in the repeated dialog 
and select Last Name.

5 Click Ascending and then click OK.
You are returned to the Repeat dialog box.

6 Click OK.
You can test the list again to see the information display in the new order.

Repeating Paragraphs

You can use the same technique you used for the list to repeat larger sections of a template, such 
as paragraphs. The paragraph that follows the list you just created needs to be merged into the 
document one time for each novel.

The paragraph includes the same variables you repeated for the list, so you can use the dialog 
you created for the list with the paragraph. Because the paragraph includes more information 
than the list, you will need to add some variables to the dialog.

1 Select the second paragraph and the blank line following it.

2 Click the HotDocs Repeat button.
The Repeat dialog box appears.

3 Click the Repeated Dialog drop-down button to display the list of dialogs. 

4 Select Novel Information and click New/Edit to edit the dialog.
The Dialog Builder appears with the dialog Novel Information displayed.

5 Drag the following variables from the Variables list to the Dialog Contents box: Genre 
of Novel, Novel's Word Count, and Brief Plot Description.

6 Click Done.
You are returned to the Repeat dialog box.

7 Click OK.
The Repeat instruction is merged into the template around the paragraph.



Lesson 10

Creating Variable-Length Tables
Sometimes you need to create a table that contains HotDocs variables and can have a different 
number of rows each time you assemble a document. HotDocs allows you to put variables in a 
table row and then repeat that row using a Repeat instruction. Just like variables in Repeat 
instructions in text, variables in a repeated table row can contain different values each time they 
are repeated.

In this lesson, you will use an invoice template. For information on repeating sections of text, 
see Lesson 9, "Using Repeats." For additional information on Repeat instructions, see Chapter 
19, "Repeat Instructions," in the HotDocs User's Guide.

Opening the Invoice

To open the Invoice template

1 In your word processor, click the HotDocs button.
Or
At the Program Manager, double-click the HotDocs icon.
The HotDocs window appears.

2 From the Learning HotDocs folder, select Invoice.

Note: If the Learning HotDocs folder does not appear, click Library, choose Open, select the 
3.0 library for your word processor (for example, msw60_30.hdl for Word 6.0), and click  
OK. Then complete step 2.

3 Click Edit.
The template opens for editing. Most of the automation is complete, but the table that will 
contain the repeated row still needs to be created.

Inserting Variables in a Table

The first step is to place HotDocs variables into a word processor table. The variables have 
already been created.

1 Position the cursor a few lines below the table that already appears in the template. (Enter 
hard returns to create more lines at the bottom of the document.)

2 Use your word processor's table feature to create a table with three rows and five 
columns.

3 In the first row, label the columns Quantity, Item Number, Title, Unit Price, and Item 
Amount.

4 Position the cursor in the first column of the second row and click the HotDocs Variable 
button.
The Variable Type dialog box appears.



5 Select Number and click OK.
The Number Variable dialog box appears.

6 Select Quantity from the Variable Name drop-down list and click OK.
The variable is inserted in the table cell.

7 Insert the following variables in order in the remaining table cells: Item Number (Text), 
Title (Text), Unit Price (Number), and Item Amount (Computation).

8 Assign the format example 9,999.00 to Unit Price and Item Amount. (Place the 
cursor on the variable in the table, click the HotDocs Variable button, select the 
format from the Format Example drop-down list, and click OK.)

Repeating a Table Row

Once you have inserted your variables into the table, you need to tell HotDocs to repeat the table 
row containing the variables. Repeats are always linked to a HotDocs dialog that contains all the 
same repeated variables, or, in the case of a repeated Computation variable, a dialog that 
contains all the variables used in the computation.

To repeat the second table row

1 Position the cursor in the first column of the second row before the variable Quantity.

2 Click the HotDocs Repeat button.
The Repeat dialog box appears.

3 Click New/Edit.
The Dialog Builder appears.

4 Type Item Information in the Dialog Name box.

5 Drag the following variables from the Variables list into the Dialog Contents box: 
Quantity, Item Number, Title, and Unit Price. 
(The final repeated variable, Item Amount, is not included in the dialog because it is a 
Computation variable and cannot be asked.)

6 Click Done.
You are returned to the Repeat dialog box. Item Information appears in the Repeated 
Dialog box.

7 Click OK.
The Repeat instruction is inserted in the first column of the second row.
(Repeat instructions inside tables do not contain END REPEAT. The end of the row 
terminates the repeat instruction.)

Summing a Table Column

You can sum a column that contains either a Number variable or a Computation variable. For 
the invoice, you need to sum the Item Amount column to compute the invoice total.



To sum the Item Amount column

1 Type Total in the fourth column of the third row.

2 Position the cursor in the fifth column of the third row and click the HotDocs Variable 
button.
The Variable Type dialog box appears.

3 Select Computation and click OK.
The Computation Variable dialog box appears.

4 Type Total in the Variable Name box.

5 From the list of models, drag SUM(COMPUTATION_VAR) into the Computation box.

6 From the list of variables, drag the Computationvariable Item Amount onto the 
COMPUTATION_VAR placeholder.

7 Select 9,999.00 from the Format Example drop-down list.

8 Click OK.
The variable is inserted into the table.

Testing the Table

Assemble the document to test the table.

1 Click the HotDocs Test button.
The Assembly Options dialog box appears.

2 Select Document and All and click OK.
The dialog Invoice Information appears.

3 Enter information and press OK to advance.
The dialog Customer Information appears.

4 Continue answering dialogs until the dialog Item Information appears.

5 Enter answers for the first item and click OK.
The Item Information dialog appears again. The number in the dialog title has 
incremented.

6 Enter answers for the second item and click OK.

7 Enter answers for as many items as you want. When you are through, click OK at an 
empty Item Information dialog.

Note: In WordPerfect 5.2, the Table Cut/Copy dialog appears. Make sure Selection is selected 
and click OK.

HotDocs displays the assembled document. The table row appears once for each time you 



entered information in the repeating dialog. The final table row contains the sum of the 
final column.

From your word processor File menu, choose Close to close the document. Then click 
the HotDocs Close button to save and close the template.



Lesson 11

Using Complex If Instructions
In Section 1, "Basics," you used If instructions to include single conditional paragraphs. Each If 
instruction controlled one paragraph. This method works well if your conditional paragraphs are 
unrelated.

Sometimes, however, you have a group of related paragraphs, only one of which can be merged 
into a document at a time. You can use one If instruction to control the entire group of 
paragraphs.

In this lesson, you will work with a collection letter template. When a collection letter is 
assembled, the text of the second paragraph changes depending on how late the payment is. 
For additional information on If instructions, see Chapter 17, "If Instructions."

Opening the Collection Letter

To open the Collection Letter template for editing
1 In your word processor, click the HotDocs button.

Or
At the Program Manager, double-click the HotDocs icon.
The HotDocs window appears.

2 From the Learning HotDocs folder, select Collection Letter.

Note: If the Learning HotDocs folder does not appears, click Library, choose Open, select the 
3.0 library for your word processor (for example, msw60_30.hdl for Word 6.0), and click  
OK. Then complete step 2.

3 Click Edit.
The template opens for editing. Most of the automation is complete, but the four versions 
of the second paragraph still need to be made conditional.

Beginning the If Instruction

You begin the If instruction by making the first of the optional paragraphs conditional.

You want the second paragraph merged into the document only when the invoice is no more 
than 30 days old. This is the paragraph beginning "Please review your records."

To make the paragraph conditional

1 Select the paragraph and the blank line below it and click the HotDocs If button.
The True/False Variable dialog box appears.
You do not want to create a True/False variable, because that would require the user to 
answer an additional question. Instead, you want to write an expression that uses 
information you already know to test whether the invoice is no more than 30 days old.

2 Click Expression.
The True/False Expression dialog box appears.



You want to test whether the date of the invoice is no more than 30 days from today.

3 From the Models list, drag DAYS FROM(DATE, DATE) into the Expression box.

4 From the Variables list, drag Invoice Date onto the first placeholder.

5 From the Models list, drag TODAY onto the second placeholder.

6 From the Operators list, drag <= into the Expression box after the final parenthesis.

7 Type 30 after the equal sign.

8 Click If.

The If instruction is merged into the template around the paragraph.

Adding the Next Paragraph to the If Instruction
The next paragraph needs to be merged into the document when the invoice is more than 30 but 
no more than 60 days old. You need to add this paragraph to the If instruction.

To add the next paragraph to the If instruction

1 Select END IF and the next paragraph (including the blank line below it).

2 Click the HotDocs If button.
The True/False Variable dialog box appears.

3 Click Expression.
The True/False Expression dialog box appears.
You need to create a two-part expression, because two conditions—the invoice is more 
than 30 days old and the invoice is no more than 60 days old—must exist for this 
paragraph to be merged in.

4 Enter DAYS FROM(Invoice Date, TODAY) > 30 in the Expression box.

5 From the Operators list, drag AND into the Expression box following 30. Make sure 
there is a space between 30 and AND.

6 Enter DAYS FROM(Invoice Date, TODAY) <= 60 in the Expression box following 
AND. Make sure there is a space between AND and DAYS.

7 Click Else If.
The second part of the If instruction is inserted around the paragraph.

On Your Own

Following the instructions above for adding a paragraph to the If instruction, add the next 
paragraph, making it conditional on the invoice date being greater than 60 but less than or equal 
to 90 days from today.

Adding the Final Paragraph



You could write an expression to control the final paragraph as well, but that is unnecessary in 
this case because you want this paragraph merged automatically whenever none of the other 
conditions are true.

To make the final paragraph conditional

1 Select END IF and the final paragraph (including the variables and the blank line 
following them). 

2 Click the HotDocs If button.
The True/False Variable dialog box appears.

3 Click Else.
The final part of the If instruction is inserted into the template around the final paragraph.

To save and close the template, click the HotDocs Close button.



Lesson 12

Inserting One Template into Another
HotDocs allows you to insert one template into another during document assembly. You can 
choose an existing template to insert, or you can create a new template from template text you 
have selected.

You may want to insert one template into another in order to

· Partition a long or complicated template
· Reuse the same paragraph(s) in more than one template
· Include two or more related documents in a single template

In this lesson, you will work with a publishing contract. Two of the paragraphs need to be made 
into separate templates, and two additional templates need to be inserted.

For more information on inserting templates, see Chapter 18, "Insert Instructions," in the 
HotDocs User's Guide.

Opening the Publishing Contract Template

To open the Publishing Contract template for editing
1 At your word processor, click the HotDocs button.

Or
At the Program Manager, double-click the HotDocs icon.
The HotDocs window appears.

2 From the Learning HotDocs folder, select Publishing Contract.

Note: If the Learning HotDocs folder does not appears, click Library, choose Open, select the 
3.0 library for your word processor (for example, msw60_30.hdl for Word 6.0), and click  
OK. Then complete step 2.

3 Click Edit.
The template is opened for you to edit. The automation is mostly complete, but some 
subtemplates need to be created and others need to be inserted.

Creating a Template from Selected Text

You want to make the paragraph on copyrights into a separate template to shorten the main 
template.

To turn selected text into a separate template

1 Select the fourth paragraph. Be sure to select the blank line below it to keep spacing 
regular.

2 Click the HotDocs Insert button.
The Insert New Template dialog box appears.



3 Type copyrght in the Filename box and click Insert & Open.
The new template is created in the word processor template directory you specified 
during installation and opened for you to edit.

Note: Ami Pro and Microsoft Word insert an extra hard return at the end of the subtemplate. 
Delete the extra hard return. (There should only be one blank line following the 
paragraph.)

4 Click the HotDocs Close button to save and close the subtemplate and return to the main 
template.

The Insert instruction is added to your template.
On Your Own

Create a new template named assign from the paragraph labeled ASSIGNMENT and insert it 
into the Publishing Contract template. Follow the instructions for creating the COPYRGHT 
template, above.

Inserting an Existing Template

You can also insert an existing template. You need to insert the template LAW following the last 
paragraph of the template.

To insert an existing template

1 Position the cursor below the Insert instruction for the template ASSIGN. Enter a hard 
return if necessary to leave a blank line between the instruction and the cursor.

2 Click the HotDocs Insert button.
The Insert Template dialog box appears.

3 Select the law template from the list of templates and click Insert.
The Insert instruction appears in the template at your cursor location.

On Your Own

Insert the template CLOSING after the LAW template. Follow the instructions for inserting the 
LAW template, above.

Testing the Template

To test the template

1 Click the HotDocs Test button.
The Assembly Options dialog box appears.

2 Select Document and All and click OK.
The first dialog appears.

3 Answer the questions and click OK to advance.



After you click OK at the dialog Novel Information, HotDocs asks you (in two separate 
dialogs) for first the name of the author and then the date of the contract, even though you 
have already answered both questions. When HotDocs asks for information twice, it 
means two variables have been used for the same information.

4 Click Cancel at the dialog asking for the date of the contract.
You are returned to the template.

Sharing Answers Across Templates

If you want the user to be asked for each item of information only once, you must make sure 
that the variables that are used for that information are identical in the main template and the 
inserted templates.

The Publishing Contract template uses the variables Author's Name and Contract Date. You 
need to open the inserted template CLOSING to see what variables it uses.

Opening the Subtemplate
To open the subtemplate

1 Position the cursor on INSERT CLOSING.

2 Click the HotDocs Insert button.
The Insert Template dialog box appears.

3 Click Insert & Open.
The template CLOSING is opened. This template uses the variables Name of Author and 
Date of Contract, instead of Author's Name and Contract Date. You need to change the 
variables to those used by the main template.

Changing the Variables
To change the variables

1 Position the cursor on the variable Name of Author in the first paragraph and click the 
HotDocs Variable button.
The Text Variable dialog box for Name of Author appears.

2 Enter Author's Name in the Variable Name box and click OK.

A dialog box appears, asking you if you want to create a new variable or rename Name of  
Author to Author's Name.

3 Click Rename.
That instance of the variable is renamed. However, the variable below the second 
signature line is still Name of Author.

4 Place the cursor on the Name of Author variable below the signature line and click the 
HotDocs Variable button.
A dialog appears telling you the variable Name of Author doesn't exist.

5 Click OK.



The Variable Type dialog box appears.

6 Select Text and click OK.
The Text Variable dialog box appears.

7 Click the Variable Name drop-down arrow button and select Author's Name from the 
list of variables.

8 Click OK.
The variable Name of Author is replaced by the variable Author's Name.

On Your Own

Rename the variable Date of Contract to Contract Date. (The variable Company Representative 
is not duplicated in the Publishing Contract template, so it does not need to be renamed.) When 
you are done, click the HotDocs Close button to close the subtemplate and test the template to 
make sure it asks for each item of information only once.

When you are through testing, click the HotDocs Close button to save and close the template.


